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Preface 

 

This User Guide is been implemented by Boot & Work, S.L. working 

under the name Industrial Shields.  

 

Purpose of the manual 

The information contained in this manual can be used as a reference to operate and 
get a better understanding of the technical data of the signal modules, power supply 
modules and interface modules.  

 

Intended Audience 

This User Guide is intended for the following audience: 

• Persons in charge of introducing automation devices. 

• Persons who design automation systems. 

• Persons who install or connect automation devices. 

• Persons who manage working automation installation. 

 

 

   Warnings: 

 

• Unused pins should not be connected. Ignoring the directive may damage the 

controller. 

• Improper use of this product may severely damage the controller. 

• Refer to the controller’s User Guide regarding wiring considerations. 

• Before using this product, it is the responsibility of the user to read the product’s User 

Guide and all accompanying documentation. 

• Maintenance must be performed by qualified personnel familiarized with the 

construction, operation, and hazards involved with the control.  

•  Maintenance should be performed with the control out of operation and 

disconnected from all sources of power.  

• Care should be taken when servicing electrostatic sensitive components. The 

manufacturer's recommendations for these components should be followed.  

• The Ardbox Family PLCs are Open Type Controllers. It is required that you install the 

Ardbox PLC in a housing, cabinet, or electric control room. Entry to the housing, 
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cabinet, or electric control room should be limited to authorized personnel. Failure to 

follow these installation requirements could result in severe personal injury and/or 

property damage. Always follow these requirements when Ardbox family PLCs. 

• In case of installation or maintenance of the Ardbox please follow the instructions 

marked in the Installation and Maintenance section. 

• Do not disconnect equipment when a flammable or combustible atmosphere is 

present. Disconnection of equipment when a flammable or combustible atmosphere is 

present may cause a fire or explosion which could result in death, serious injury and/or 

property damage. 

 

 

   Avertissements: 

 

• Les broches non utilisées ne doivent pas être connectées. Ignorer la directive peut 

endommager le contrôleur. 

• Une utilisation incorrecte de ce produit peut endommager gravement le contrôleur. 

• Reportez-vous au Guide de l’utilisateur du contrôleur pour les considérations de 

câblage. 

• Avant d’utiliser ce produit, il incombe à l’utilisateur de lire le Guide de l’utilisateur du 

produit et la documentation qui l’accompagne. 

• La maintenance doit être effectuée par personnel qualifié familiarisé avec la 

fabrication, le fonctionnement et les dangers liés au contrôleur. 

• La maintenance doit être effectuée avec l’équipement hors service et déconnectée de 

toutes les sources d'alimentation. 

• Faites attention lors de l'entretien des composants sensibles à l'électricité statique. 

Les recommandations du fabricant pour ces composants doivent être suivies. 

• Les automates de la famille Ardbox sont des contrôleurs de type ouvert. Il est 

nécessaire d'installer l'automate Ardbox dans un boîtier, une armoire ou une salle de 

contrôle électrique. L'accès au boîtier, à l'armoire ou à la salle de commande 

électrique doit être limité au personnel autorisé. Le non-respect de ces exigences 

d'installation peut entraîner des blessures graves et/ou des dommages matériels 

importants. Respectez toujours ces exigences lors de l'installation des automates de la 

famille Ardbox. 

• En cas d'installation ou de maintenance du Ardbox, veuillez suivre les instructions 

indiquées dans la section Installation et Maintenance. 

• Ne débranchez pas l'équipement en présence d'une atmosphère inflammable ou 

combustible. La déconnexion de l'équipement en présence d'une atmosphère 

inflammable ou combustible peut provoquer un incendie ou une explosion pouvant 

entraîner la mort, des blessures graves et/ou des dommages matériels. 
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Application Considerations and Warranty 

Read and Understand this Manual 

Please read and understand this manual before using the product. Please consult your 

comments or questions to Industrial Shields before using the product. 

 

Application Consideration                               

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. 

THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR 

PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE 

NOT RATED OR DESSIGNED FOR SUCH PURPOSES.  

Please know and observe all prohibitions of use applicable to the products.  

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY 

WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED 

TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.  

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE 

PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE 

OVERALL EQUIPMENT OR SYSTEM.  

Industrial Shields shall not be responsible for conformity with any codes, regulations or 

standards that apply to the combination of products in the customer’s application or use 

of the product. 

The following are some examples of applications for which particular attention must be  

given. This is not intended to be an exhaustive list of all possible uses of the products, 

nor is it intended to imply that the uses may be suitable for the products: 

• Systems, machines, and equipment that could present a risk to life or property. 

• Nuclear energy control systems, combustion systems, railroad systems, 

aviation systems, medical equipment, amusement machines, vehicles, safety 

equipment, and installation subject to separate industry or government 

regulations. 

• WARNING: On outdoor operations, locations involving potential chemical 

contamination or electrical interference, conditions or uses not described in this 

document please contact Industrial Shields for further information. 

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third-party 

certification documents identifying ratings and limitations of use that apply to the 

products. This information by itself is not sufficient for a complete determination of the 

suitability of the products in combination with the system, machine, end product, or 

other application or use. 
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Intended use or of Industrial Shields products                                                  

Consider the following: 

Industrial Shields products should only be used for the cases of application foreseen in 

the catalogue and the associated technical documentation. If third-party products and 

components are used, they must have been recommended or approved by Industrial 

Shields.  

The correct and safe operation of the products requires that your transport, storage, 

installation, assembly, operation and maintenance have been carried out in a correct It 

must respect the permissible ambient conditions. You should also follow the indications 

and warnings that appear in the associated documentation. 

The product / system dealt with in this documentation should only be handled or 

manipulated by qualified personnel for the task entrusted and observing what is 

indicated in the documentation corresponding to it, particularly the safety instructions 

and warnings included in it. Due to their training and experience, qualified personnel 

are in a position to recognize risks resulting from the handling or manipulation of such 

products / systems and to avoid possible hazards. 

Disclaimers             

Weights and Dimensions 

Dimensions and weights are nominal and they are not used for manufacturing 

purposes, even when tolerances are shown. 

Performance Data 

The performance data given in this manual is provided as a guide for the user in 

determining suitability and does not constitute a warranty. It may represent the result of 

INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual 

application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS 

Warranty and Limitations of Liability. 

Change in Specifications 

Product specifications and accessories may be changed at any time based on 

improvements and other reasons. 

It is our practice to change model numbers when features are changed, or published 

ratings or when significant construction changes are made. However, some 

specifications of the products may be changed without any notice. When in doubt, 

special numbers may be assigned to fix or stablish key specifications for your 

application on your request. Please consult with your INDUSTRIAL SHIELDS 

representative at any time to confirm actual specifications of purchased products. 
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Errors and Omissions 

The information in this document has been carefully checked and is believed to be 

accurate; however, no responsibility is assumed for clerical, typographical, or 

proofreading errors, or omissions. 

Residual Risks 

The control and drive components of an Industrial Shields PLC are approved for 

industrial and commercial use in industrial line supplies. Their use in public line 

supplies requires a different configuration and/or additional measures. These 

components may only be operated in closed housings or in higher-level control 

cabinets with protective covers that are closed, and when all of the protective devices 

are used. These components may only be handled by qualified and trained technical 

personnel who are knowledgeable and observe all of the safety information and 

instructions on the components and in the associated technical user documentation. 

When carrying out a risk assessment of a machine in accordance with the EU 

Machinery Directive, the machine manufacturer must consider the following residual 

risks associated with the control and drive components of a PDS.  

1. Unintentional movements of driven machine components during commissioning, 

operation, maintenance, and repairs caused by, for example: − Hardware defects 

and/or software errors in the sensors, controllers, actuators, and connection technology 

− Response times of the controller and drive − Operating and/or ambient conditions not 

within the scope of the specification − Condensation / conductive contamination − 

Parameterization, programming, cabling, and installation errors − Use of radio devices / 

cellular phones in the immediate vicinity of the controller − External influences / 

damage.  

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by, 

for example: − Component malfunctions − Software errors − Operating and/or 

ambient conditions not within the scope of the specification − External 

influences / damage. 

3. Hazardous shock voltages caused by, for example: − Component malfunctions − 

Influence of electrostatic charging − Induction of voltages in moving motors − Operating 

and/or ambient conditions not within the scope of the specification − Condensation / 

conductive contamination − External influences / damage  

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose 

a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are 

too close.  

5. Release of environmental pollutants or emissions as a result of improper operation 

of the system and/or failure to dispose of components safely and correctly. 
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Warranty and Limitations of Liability 

Warranty 

Industrial Shields’s exclusive warranty is that the products are free from defects in 

materials and workmanship for a period of one year (or other period if specified) from 

date of sale by Industrial Shields. 

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, 

EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-

INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS. 

ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE 

HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE 

REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS 

ALL OTHER WARRANTIES, EXPRESS OR IMPLIED 

 

Limitations of Liability 

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, 

OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN 

ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS 

BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY. 

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY, 

REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL 

SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY 

HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO 

CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR 

REPAIR. 
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1. Ardbox Relay HF: General Features 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

COMPACT PLC ARDUINO ARDBOX 20I/Os 
RELAY HF PLUS  MODBUS & LoRa 

 

Input Voltage 
 

12 to 24Vdc  

Fuse protection (2.5A) 
Polarity protection 

 

Input rated voltage 
 

24 Vdc 
 

 

Rated Power 30 W  

I Max.  1,5A  

Size 100x45x115  

Clock Speed 16MHz  

Flash Memory 
32KB of which 4KB are used by 

bootloader 
 

SRAM 2.5KB  

EEPROM 1KB  

Communications 
 LoRa -- USB -- RS232 -- RS485 -- 

SPI -- TTL 
RS485  

TOTAL Input points 10  

TOTAL Output points 10  

An/Dig Input 10bit 
(0-10Vcc) 

 
0 to 10Vac 

Input Impedance: 39K 
Separated PCB ground 
Rated Voltage: 10Vac 

 
5 to 24Vdc 

I min: 2 to 12 mA 
Galvanic Isolation 

         Rated Voltage: 24 Vdc 
 

  

 

* Interrupt isolated Input 
HS 

(24Vcc) 

5 to 24Vdc 
I min: 2 to 12 mA 
Galvanic Isolation 

Rated Voltage: 24Vdc 

 
5 to 24Vdc 

I min: 3/6 mA 
Separated PCB ground 

 

Analog Output 8bit 
(0-10Vcc) 

0 to 10Vac 
I max: 20 mA 

Separated PCB ground 
Rated Voltage: 10Vac 
 
 

 

Digital Isolated Output 
(24Vcc) 

5 to 24Vdc 
I max: 70 mA 

Galvanic Isolation 
Diode Protected for Relay 

Rated Voltage: 24Vdc 
 
 

Imax 24Vdc: 410 mA 

Digital Isolated Output 
Relay 

220V Vdc 
Galvanic Isolation 

Diode protected for Relay 
 
 

Imax: 5A 

PWM Isolated Output 
8bit (24Vcc) 

5 to 24Vdc 
I max: 70 mA 

Galvanic Isolation 
Diode Protected for Relay 

Rated Voltage: 24Vdc  

PWM Isolated 
Output 8bit (24Vcc) 

Expandability 
LoRa  – RS232 – RS485 – SPI – 

TTL   
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2. Technical Specifications 

 General Specifications: 

Power supply 
voltage 

DC power supply    12 to 24Vdc   

Operating 
voltage range 

DC power supply 11.4 to 25.4Vdc  

Power 
consumption 

DC power supply 30VAC max. 

External 
power supply 

Power supply voltage 24Vdc  

Power supply output 
capacity 

700 mA 

Insulation resistance 
20MΩ min. at 500Vdc between the AC terminals and the protective ground 
terminal. 

Dielectric strength 
2.300 VAC at 50/ 60 Hz for one minute with a leakage current of 10mA 
max. Between all the external AC terminals and the protective earth 
terminal. 

Shock resistance 80m/s2 in the X, Y and Z direction 2 times each. 

Ambient temperature (operating) 0º to 60ºC 

Ambient humidity (operating) 10% to 90% (no condensation) 

Ambient environment (operating) With no corrosive gas 

Ambient temperature (storage) -20º to 60ºC 

Power supply holding time 2ms min. 

Weight 352g max.  

 

 Performance Specification: 

Arduino Board ARDUINO LEONARDO 

Control method Stored program method 

I/O control method Combination of the cyclic scan and immediate refresh processing methods. 

Programming language 
Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform 
composed of a programming language. “similar to the C”. 
http://arduino.cc/en/Tutorial/HomePage 

Microcontroller ATmega32u4 

Flash Memory 32KB of which 4KB are used by bootloader 

Program capacity (SRAM) 2.5KB 

EEPROM 1KB 

http://arduino.cc/en/Tutorial/HomePage
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Clock Speed 16MHz 

 Symbology 

Table that includes all the symbology that is used in the serigraph of the Ardbox  Relay HF+: 

Symbol 
 

Standard No. / 
Standard Title 

 

Standard 
Reference No. / 

Symbol Title 
Symbol Meaning 

 

IEC 60417 / 
Graphical symbols 

for use on 
equipment 

5031 / Direct 
Current 

Indicates that the equipment is 
suitable for direct current only; 
to identify relevant terminals 

 

IEC 60417 / 
Graphical symbols 

for use on 
equipment 

 

5032 / Alternating 
Current 

Indicates that the equipment is 
suitable for alternating current 

only; to identify relevant 
terminals 

 

 
IEC 60417 / 

Graphical symbols 
for use on 
equipment 

 

5130 / Pulse 
General 

To identify the control by 
which a pulse is started. 

 

 IEC 60417 / 
Graphical symbols 

for use on 
equipment 

 

5017 / Earth, 
Ground 

To identify an earth (ground) 
terminal in cases where 

neither the symbol 5018 nor 
5019 is explicily required. 

 

 

IEC 60417 / 
Graphical symbols 

for use on 
equipment 

 

5115 / SIgnal lamp 

To identify the switch by 
means of which the signal 

lamp(s) is (are) switched on or 
off. 

 

Medical Devices 
Directive 

93/42/EEC 
CE Marking 

CE marking indicates that a 
product complies with 

applicable European Union 
regulations 

 
 

ISO 7000/ 
Graphical symbols 

for use on 
equipment 

 

0434B / 
Warning symbol 

Indicates a potentially 
hazardous situation which, if 
not avoided, could result in 

death or serious injury 

 
ISO 7000/ 

Graphical symbols 
for use on 
equipment 

 

5036 / Dangerous 
Voltage 

To indicate hazards arising 
from dangerous voltages 
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3. Precautions 

Read this manual before attempting to use the ARDBOX 20 I/Os Relay HF PLUS Modbus & LoRa 
and follow its descriptions for reference during operation. 

 Arduino Board 

The ARDBOX 20 I/Os Relay HF PLUS Modbus & LoRa PLCs include Arduino Leonardo Board as 

controller.  

 Intended Audience 

This manual is intended for technicians, which must have knowledge on electrical systems. 

 General Precautions 

The user must operate Ardbox according to the performance specifications described in this 

manual. 

Before using ARDBOX 20 I/Os Relay HF PLUS Modbus & LoRa under different conditions from 

what has been specified in this manual or integrating ARDBOX 20 I/Os Relay HF PLUS Modbus 

& LoRa to nuclear control systems, railroad systems, aviation systems, vehicles, combustion 

systems, medical equipment, amusement machines, safety equipment and other systems, 

machines, and equipment that may have a serious influence on lives and property if used 

improperly, consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and 

performance characteristics of Ardbox are sufficient for the systems, machines, and 

equipment, and be sure to provide the systems, machines, and equipment double safety 

mechanisms. This manual provides information for programming and operating the Ardbox. 
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4. Software interface 

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C 

language. They can also be programmed using directly C but it is much easier working with 

Arduino IDE as it provides lots of libraries that helps in the programming.   

Furthermore, Industrial Shields provides boards for programming the PLCs much easier. 

Basically, it is no needed to define the pins and if that pins are inputs or outputs. Everything is 

set up automatically if using the boards. 

In order to install Industrial Shields boards, these are the steps that must be followed. 

Requirements: 

Arduino IDE 1.8.0 or above (better to always have the latest version). 

 

 

Steps: 

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. In Additional Boards URLs write the following: 

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json 

3. Press OK to save the changes. 

 

4. Go to: Tools -> Board: … -> Boards Manager  

 

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json
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5. Search for industrialshields. 

 

 

 

 

 

 

 

 

 

 

6. Click install (selecting the latest version). 

 

Following these steps, you will be able to use now the Industrial Shields Boards: 
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Once the Ardbox Family is selected, an extra option will appear on Tools: 

- Select the correct Ardbox Relay HF PLUS Board (Ardbox Relay HF+ w/HW RS-232 or 
Ardbox Relay HF+ w/HW RS-485) depending on your jumpers & switch configuration.  

 
 

Also, there are some examples of programming in File -> Examples -> Ardbox LoRa Family. 

Furthermore, there are some extra libraries that can be found in Industrial Shields GitHub. 

https://github.com/IndustrialShields/ 

 

 

 

 

 

 

 

 

 

 

 

 

 

https://github.com/IndustrialShields/
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5. How to connect PLC Arduino to PC 

 

- Connect USB port from PLC to PC. 

NOTE:  
Ardbox Family uses micro USB cable.  
 
 
 

- Open Arduino IDE interface: 
- Select Industrial Shields boards -> Ardbox LoRa Family 
- Select correct port. 
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6. How to connect PLC to power supply 

- Ardbox Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT 

REVERSAL!  

- Make sure that the live and GND connector of the power supply match the PLC. 

- Make sure that the power supply mains output is not higher than 24Vdc. 

 

- Suggested power suppliers  

 

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types 

of electrical devices and their accessories, regardless of where use of the device is intended.  

The equipment must be powered from an external power source in accordance with IEC 

61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-

1. 

WARINING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of 

the equipment must be separated from the dangerous voltage cables. 

 

 

 

 

Compact DIN rail power supply. Assembled on 35mm 

DIN Rail: 

-12Vdc / 24Vdc 

-2.5A 

-30W 

 

Industrial Shields power supplies provide parallel 

operation, overvoltage protection, and overcurrent 

protection. There is a LED inductor for power status, 

the power supply is certified according to UL. 
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7. Ardbox Relay I/O pinout: 

7.1 Zone Connections 
 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
HS*: Hardware Serial 
SS*: Software Serial 
 
1  See section 8 to enable these connections 
2  See section 9 to enable these connections 
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F
u
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MISO 
MOSI 
SCK 

RESET 
5VdC 
GND 

RX-RS-2321,2 
TX-RS-2321,2 

NC 
NC 

 

 

 

 

 
R1 
R2 
R3 

 
 
 

GND 
24V 

 
 

 
 
 
 
 
 
 
 

14 
16 
15 
- 
- 

- 
8 
4 
- 
- 
 
 
 
 
 

10 
9 

6 
 
 

 
- 
- 

 
 
 
 
 
 
 
 
 
 

SPI-MISO 
SPI-MOSI 

SPI-CLOCK 
SPI-RESET 
5V Output 

GND 
Serial/RS232  
Serial/RS232 

Not Connected 
Not Connected 

 
 
 
 
 

Relay 1 Out 
Relay 2 Out 
Relay 3 Out 

 
 

 
GND 

- 

 
 
LEFT ZONE 
 
 
 
 
Switch config*  
(see section 8 for Communications  
configuration. Enabling Communications  
disables some  I/Os) 
  

 

 

 

Communications pins 
 

 

 

 

Relay Outputs 

 
 
 
Power supply connectors  
(24Vdc – GND) 
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*Depending on the mode HD/FD the Y+/Z- analog outputs pins are enabled or disabled. See 

section 9 to see the configurations  
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R
S
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B- 

A+ 

Z-/A0.1 

Y+/A0.0 

R4 

NC 

NC 

I0.8 

I0.7 

I0.6 

I0.51 

I0.41 

I0.32 

I0.22 

I0.1 

NC 

R6 

R71 

R81 

- 

- 

- 

- 

5 

- 

- 

22 

21 

20 

19 

18 

8 

4 

12 

- 

7 

0 

1 

RS485 

RS485 

RS485/Analog Output 

RS485/Analog Output 

Relay 4 Out 

Not Connected 

Not Connected 

Analog/Digital Input 

Analog/Digital Input 

Analog/Digital Input 

Analog/Digital Input 

Analog/Digital Input 

Analog/Digital Input 

Analog/Digital Input 

Digital Input 

Not Connected 

Relay 6 Out 

Relay 7 Out 

Relay 8 Out 

        Input / Output LED         Power LED  Arduino Reset button 

                                  
                   

 

 
 
RIGHT ZONE 
 
 
RS-485 pins 
Analog Outputs Pins 
 
 
Relay Outputs 
  
  

 

Digital/Analog Inputs pins 

 

 

 

Relay Outputs 

Config switch * 
(see section 8 for communications 
configuration) 
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8. Switch configuration 

 General Switches Configurations 

 
LEFT ZONE SWITCH 

Communications and inputs/outputs can not work simultaneously.  
 
 

 

               

1. NC – Not Connected 
2. HD*/FD* – Choosing between Half/Full Duplex for the RS485 communication. In order 

to use Full Duplex, it has to be considered the TOP ZONE and the JUMPER ZONE(*see 
section 9). 

3. LoRa / NC – This switch have to be in ON position to enable LoRa communication.  
4. LoRa / NC– This switch have to be in ON position to enable LoRa communication.  
5. RE-RS485 / I0.4 – If this switch is ON the RE-RS485 is activated, otherwise the I0.4 will 

be activated.  
6. I0.4 / RE-RS485 – If this switch is ON the I0.4 is activated, otherwise the RE-RS485 will 

be activated.  
 
Note* To work with RS-485 RE, switch number 5 at ON and number 6 at OFF. 
 

7. DE-RS485 / I0.5 – If this switch is ON the DE-RS485 is activated, otherwise the I0.5 will 
be activated.  

8. I0.5 / DE-RS485– If this switch is ON the I0.5 is activated, otherwise the DE-RS485 will 
be activated.  
 
Note* To work with RS-485 DE, switch number 7 at ON and number 8 at OFF. 
 
 
 
 
 
 
 
 

 
 

LEFT ZONE 

SWITCH ON OFF 

NC - - 

HD/FD* Half Duplex Full Duplex 

LoRa/NC LoRa NC  

LoRa/NC LoRa NC 

RE-RS485/I0.4 RE-RS485 I0.4 

I0.4/RE-RS485 I0.4 RE-RS485 

DE-RS485/I0.5 DE-RS485 I0.5 

I0.5/DE-RS485 I0.5 DE-RS485 
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TOP ZONE SWITCH 
 
 
 
 
 
 
 
 
 
 
 

Communications and outputs cannot work simultaneously.  

 

4. RS* / R8  - If this switch is ON the RS* is activated, otherwise the R8 will be activated.  

3. R8 / RS* - If this switch is ON the R8 is activated, otherwise the RS* will be activated.  

2. RS* / R7 - If this switch is ON the RS* is activated, otherwise the R7 will be activated.  

1. R7 / RS* - If this switch is ON the R7 is activated, otherwise the RS* will be activated.  
 

Note* RS * can be RS-485 or RS-232 depending on the jumper configuration you have chosen. 
To work with RS*, switches number 1 and 3 at ON and number 2 and 4 at OFF. 
 

 RS- 485 Switch configuration 

 

RS-485 TOP ZONE: In order to enable the RS-485 protocol the 
TOP ZONE must be configured as it is shown in the table.  
 
Having this setup, the R7 & R8 are disabled. 
 
 
 

 

 

RS-485 LEFT ZONE: In order to enable the RS-485 
communication protocol it is necessary that the switches 
of the left zone are configured as it is showed in the 
table.  
The ones marked with “-“ mean that they don’t affect the 

RS-485 communication protocol. 

 

 
 
 

* To enable the RS-485 communication it is needed to configure also the jumpers, see Section  
 
 
 
 
 

TOP ZONE 

SWITCH ON OFF 

RS* /  R8 RS* R8 

R8 /  RS* R8 RS* 

RS* / R7 RS* R7 

R7  / RS*  R7 RS* 

 
TOP ZONE 

SWITCH MODE 

RS* /  R8 ON 

R8 /  RS* OFF 

RS* / R7 ON 

R7  / RS*  OFF 

LEFT ZONE 

SWITCH MODE 

NC - 

HD/FD* ON/OFF 

R5/Pin3 - 

I0.0/LoRa - 

RE-RS485/I0.4 ON 

I0.4/RE-RS485 OFF 

DE-RS485/I0.5 ON 

I0.5/DE-RS485 OFF 
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 RS- 485 Switch configuration 

 

RS-232 TOP ZONE: In order to enable the RS-232 
communication protocol it is necessary that the switches of 
the top zone are configured as it is shown in the table. 
 
 
 

 

RS-232 LEFT ZONE: In order to enable the RS-232 
communication protocol it is necessary that the switches 
of the left zone is configured as it is showed in the table. 
None of them affects to the RS-232 communication but if 
you are using it you can use also use the inputs I0.4 and 
I0.5.  
The ones marked with “-“ mean that it does not affect 
the RS-232 communication protocol 

 
 
 

* To enable the RS-485 communication it is needed to configure also the jumpers, see Section  

 

9. Jumper configuration 

 General jumper configuration 

 
This jumper zone makes the selection between using the RS-485 Full 
Duplex or the Analog Outputs. If it is wanted to use the RS-485 Full 
Duplex communication protocol the Y+ must be connected to ENABLE, 
and Z- also connected to ENABLE. If it is wanted to use the Analog 
Outputs, The A0.0 must be connected to ENABLE, and A0.1 also 
connected to Enable  
 
This jumper zone makes the choosing between connecting the inputs 
I0.2, I0.3 to pins 4 and 8 of the Arduino Leonardo respectively, or 
connect the RS-232 ports to activate the Software Serial RS-232. In 
order to use the inputs I0.2,I0.3 the jumper must be connected to the 
pins 4 and 8. So I0.2 must be connected with D4 and I0.3 must be 
connected to D8. 
 

 
This jumper makes the choosing between connecting MAX232 to pins 
0,1 of the Arduino Leonardo or with the MAX485. In order to use the 
RS-232 Hardware Serial protocol both RS-232 must be connected to 
the D1/D0. In order to use the RS-485 Hardware Serial protocol both   

             RS-485 must be connected to the D1/D0. 
 
*The jumpers that are not connected to the middle jumpers MUST NOT be connected anywhere.  
 

 
TOP ZONE 

SWITCH MODE 

RS* /  I0.2 OFF 

I0.2 /  RS* ON 

RS* / I0.3  OFF 

I0.3  / RS*  ON 

LEFT ZONE 

SWITCH MODE 

NC - 

HD/FD* ON/OFF 

R5/Pin3 - 

I0.0/LoRa - 

I0.4/RE-RS485 ON 

RE-RS485/I0.4 OFF 

I0.5/DE-RS485 ON 

DE-RS485/I0.5 OFF 

JUMPER ZONE 1 

 LEFT RIGHT 

Y+ Z- 

ENABLE ENABLE 

A0.0 A0.1 

JUMPER ZONE 2 

 LEFT RIGHT 

I0.2 I0.3 

D4 D8 

RS-232 RS-232 

JUMPER ZONE 3 

UP RS-485 D1 RS-232 

DOWN RS-485 D0 RS-232 
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10. Hardware Serial RS-232 & RS-485 Configuration 

  Hardware Serial RS-485 

 
In order to enable the Hardware Serial RS-485 the total configuration of the Ardbox Relay HF 

PLUS will be:  

Switch configuration: 
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Jumper configuration: 

ZONE 1                   ZONE 2               ZONE 3 

                   

 

Available communication protocols: 

• Hardware Serial RS-485 

• SPI 

• TTL 

• USB 

 

 

 Hardware Serial RS-232 

In order to enable the Hardware Serial RS-485 the total configuration of the Ardbox Relay HF 

will be: 

Switch configuration: 

 

  

 
 

Jumper configuration: 

ZONE 1                   ZONE 2               ZONE 3 
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o Available communication protocols: 

• Hardware Serial RS-485. 

• SPI 

• TTL 

• USB 

 

 

 

 

 

11. Ardbox - Arduino  I/Os 5V pins 

The Ardbox has some of the Leonardo board pins available.  These pins can be programmed 

according to Arduino features such as I/Os operating at 5V or any additional features present 

in the pins. As these pins are directly connected to the Arduino Leonardo board they are not as 

well protect as the normal inputs. These pins are mainly meant to be used as prototyping. 

 

 

 

 

*IMPORTANT: Do not connect the terminals in the chart above to voltages higher than 5V. 

These terminals provide direct access to the Leonardo board. 

Apart from the switch configuration there are some special conditions depending on these 5V. 

Now it is going to be shown the considerations to operate with these pins. 

 Pin 3 

This pin is only referred to the input I0.6. If the switch configuration is in OFF position the pin 

Pin 3 will be available. 

This pin is not stablished with a pull-up or a pull-down configuration. The state of this pin is 

unknown. If this pin must be used, it requires a pull-up or a pull-down configuration. The 

Arduino board allows the pin to be set in a pull-up configuration. If not it must be stablished an 

external pull-up or pull-down circuit in order to correctly work with this pin. 

 

 

Ardbox terminal Arduino pin 

SCL – Pin 3 3 

SDA – Pin 2 2 

MISO 14 

SCK 15 

MOSI 16 
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12.  I/0 technical details 

 
Digital Output Waveform 

 

 

 

 

 

 

 

 

Digital Output Turn-off 
 

 

 
 
 
PWM Waveform 
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Analog Out Turn-on 
 

 

 
Analog Out Turn-off 
 

 

 
 
 
 
 
 
Analog/Digital Input Turn-on 
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Analog/Digital Input Turn-off 
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13. Typical Connections 
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14. Connector details 

 

The connector inside the PLCs that mounts on the PCB is  MC 0,5/10-G-2,5 THT – 1963502 

from Phoenix contact. MC0,5/10-G-2,5THT  

For I/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix 

contact. FK-MC 0,5/10-ST-2,5 

Connection details: 

 

 

 

 

 

 

 

 

 

Article reference MC 0,5/10-G-2,5 THT 

Height 8,1mm 

Pitch 2,5mm 

Dimension 22,5mm 

Pin dimensions 0,8x0,8mm 

Pin spacing 2,50mm 

Article reference FK-MC 0,5/10-ST-2,5 

Rigid conduit section min. 0,14 mm² 

Rigid conduit section max. 0,5 mm² 

Flexible conduit section min. 0,14 mm² 

Flexible conduit section max. 0,5 mm² 

Conduit section AWG/kcmil min. 26 

Conduit section AWG/kcmil max. 20 

https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1963502&library=usen&tab=1
https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1881406&library=usen&tab=1#General
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15. ARDBOX Family Dimensions: 

 

45mm width 

 

 

 

- DIN rail mounting: 
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16. Installation and Maintenance 

 
 
Notes for installation: 
 

- The installation position should be free from the following: dust or oil smoke, 
conductive dust, corrosive or flammable gas, high temperature, condensation, and 
rain.  

- Besides, vibration and impact also affect the PLC normal operation and shorten its 
lifespan; electric shock, fire or misact also damages the product. During drilling or 
wiring, prevent the metal particles or wire segments from falling into the PLC casing, 
which may cause fire, fault or misact.  

- After the PLC installation, clean the ventilation duct to prevent blocking, which may 
cause bad ventilation, or even fire, faults or misact.  

- Do not online connect, plug or unplug cables, which is apt to cause electric shock or 
damage the circuit. Installation and wire connection must be firm and reliable. Poor 
connection could cause misact.  

- Use shielded twisted pair for the I/O of high frequency signal and analog signal to 
improve system IMS. 

 
The installation environment should be free from dust, oil smoke, conductive particle, 
corrosive or flammable gases, high temperature, condensation, and rain.  
 
Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan. 
It is recommended to install the PLC, together with the matching switches and contactors, 
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high 
ambient temperature or heat generating equipment nearby, install forced convection 
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring, 
prevent the metal particles or wire segments from falling into the PLC casing, which may 
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent 
blocking, which may cause bad ventilation, or even fire, faults or misact. 
 
The only way to disconnect the equipment from the electrical network is by removing the 
connectors that feed the equipment. Once installed in the electrical cabinet it is very 
important to ensure the power connectors for proper operation. 
 
 

Separate the ARDBOX 20 I/Os Relay HF PLUS Modbus & LoRa  I/Os PLUS from heat, 
high voltaje and eletrical noise: 

 
 
Always separate the devices that generate high voltage and high electrical noise from the 
ARDBOX 20 I/Os Relay HF PLUS. When configuring the layout of the ARDBOX 20 I/Os Relay 
HF PLUS Modbus & LoRa inside your panel, consider the heat-generating devices and 
locate the electronic-type devices in the cooler areas of your cabinet. Reducing the 
exposure to a high-temperature environment will extend the operating life of any 
electronic device. Consider also the routing of the wiring for the devices in the electric 
cabinet. Avoid placing low-voltage signal wires and communications cables in the same 
tray with AC power wiring and highenergy, rapidly-switched DC wiring.  
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Provide adequate clearance for cooling and wiring ARDBOX 20 I/Os Relay HF PLUS. Is designed 
for natural convection cooling. For proper cooling, you must provide a clearance of at least 25 
cm above and below the devices. Also, allow at least 25 cm of depth between the front of the 
modules and the inside of the enclosure. 

 
Notes for maintenance: 
 
A well-planned and executed maintenance program is essential to the satisfactory operation of 
solid-state electrical equipment. The kind and frequency of the maintenance operation will 
vary with the kind and complexity of the equipment as well as with the nature of the operating 
conditions. Maintenance recommendations of the manufacturer or appropriate product 
standards should be followed. 
 
The following factors should be considered when formulating a maintenance program:  
 

- Maintenance must be performed by qualified personnel familiar with the construction, 
operation, and hazards involved with the control.  

-  Maintenance should be performed with the control out of operation and 
disconnected from all sources of power.  

- Care should be taken when servicing electrostatic sensitive components. The 
manufacturer's recommendations for these components should be followed.  

- Ventilation passages should be kept open. If the equipment depends upon auxiliary 
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when 
necessary) should be made of these systems.  

- The means employed for grounding or insulating the equipment from ground should 
be checked to assure its integrity. 

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks, 
should be removed according to the manufacturer's instructions, if provided; 
otherwise, the manufacturer should be consulted. Care must be taken to avoid 
damaging any delicate components and to avoid displacing dust, dirt, or debris in a 
way that permits it to enter or settle into parts of the control equipment. 

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and 
dirt should be removed from the top of the enclosures before opening doors or 
removing covers.  

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g., 
polychlorinated biphenyls (PCBs) found in some liquidfilled capacitors) must be 
disposed of as described in Federal regulations. 

 
Safety rules for maintenance personnel 
 

Consider the following steps to follow. A false manoeuvre could be the cause of an 
accident or material damage. 
Do not disassemble or modify the modules. This could lead to breakdowns or 
malfunctions and could lead to injuries or fire. 

 
- All types of radio communication devices, including mobile phones and personal 
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all 
directions. Failure to observe this precaution exposes malfunctions caused by excess of 
temperature. 



Ref. 015001001300           Rev.2: 10-05-2021       

 

38 
 

- Disconnect the external power supply of the system (on all phases) before connecting 
or disconnecting a module. Failure to observe this precaution may cause faults or 
malfunctions of the module. 
- Tighten the screws of the terminal ports and the screws of the connectors within the 
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires 
and cause malfunctions. Excessive tightening can damage the screws and / or the 
module, with the risk of falling, short circuits and malfunctions. 
- Before handling a module, dispose of the electrostatic charge accumulated by the 
human body by touching a suitable conductive object. Failure to observe this 
precaution may cause faults or malfunctions of the module. 

 
Repair note: 
 

If the equipment is suitable to be repaired, it must be verified that the equipment 
remains in a safe state after repair. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Ref. 015001001300           Rev.2: 10-05-2021       

 

39 
 

17. Revision Table 

Revision Number Date Changes 

0 26/08/2020 First implementation 

1 15/01/2021 Change section 7.1 

2 10/05/2021 Change section 8 
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About Industrial Shields: 
 

Direction: Fàbrica del Pont, 1-11 

Zip/Postal Code: 08272  

City: Sant Fruitós de Bages (Barcelona)  

Country: Spain 

Telephone: (+34) 938 760 191 / (+34) 635 693 611 

Mail: industrialshields@industrialshields.com 

mailto:industrialshields@industrialshields.com

